


Legal Disclaimer

Legal Disclaimer
Copyright Notice

All rights reserved © Shenzhen Inovance Technology Co.,Ltd.

The copyright of this guide belongs to Shenzhen Inovance Technology Co., Ltd. Without written
permission of the company, no unit or individual is allowed to extract, copy, modify, translate, or
disseminate the guide in any form.

Legal action will be taken against infringement.

Trademark Notice

is the registered trademark of Shenzhen Inovance Technology Co., Ltd. and its
affiliates. All other trademarks or registered trademarks mentioned in this guide are the property of
their respective owners. The use of these trademarks by third parties for their own purposes without
written authorization will infringe upon the rights of their owners.

Disclaimer of Liability

The content of this guide may be not fully match the actual product due to continuous product and
technical updates. In case of deviations, the actual product shall prevail.

This guide is subject to change without notice.

Waste Disposal

The storage, use, and disposal of this product (including options) must comply with local laws and
regulations.

Personnel Requirements

The product/system described in this guide can only be operated by qualified professionals.
Operations must comply with this guide, especially alarm notices and safety instructions. Qualified
personnel can identify the risks of the product/system and prevent possible dangers.

Usage Requirements

Proper transportation, storage, assembly, installation, commissioning, operation, and maintenance
are prerequisites for the safe and normal operation of the product. It is necessary to use the product in
proper environments by following the instructions in this guide.
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Preface
Introduction

GS20-EIP-8L is an IP67 master module that transfers EtherNet/IP communication to IO-Link
communication. The module is equipped with eight IO-Link ports and can connect up to eight IO-Link
devices (Class A type).

This guide introduces the product information, mechanical installation, electrical installation, program
commissioning, and troubleshooting of the product.

Standards Compliance

The following table lists the certifications, directives, and standards that the product may comply with.
For details about the acquired certificates, see the certification marks on the product nameplate.

Certification Directive Standard
CE
Certification

EMC Directive 2014/30/EU 24 VDC products:

EN 61131-2

220 VAC products:

EN 61131-2

EN 61000-3-2

EN 61000-3-3
LVD 2014/35/EU EN 61010-1

EN 61010-2-201
RoHS Directive 2011/65/EU amended by

(EU)2015/863
EN IEC 63000

UL/cUL
Certification

- UL 61010-1

UL 61010-2-201

CAN/CSA-C22.2 No. 61010-1

CSA C22.2 NO. 61010-2-201
KCC
Certification

- -

EAC
Certification

- -

UKCA
Certification

Safety Regulations Electrical Equipment
(Safety) Regulations 2016

EN 61010-1

EN 61010-2-201
EMC Regulations Electromagnetic

Compatibility Regulations
2016

24 VDC products:

EN 61131-2

220 VAC products:

EN 61131-2

EN 61000-3-2

EN 61000-3-3
RoHS Regulations Directive (RoHS)

Regulations 2012
EN IEC 63000
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More Data
Name Code Description

GR20-16EMNL Digital Input and
Output Module User Guide

PS00007355 Introduces the product information, mechanical
installation, and electrical installation of the
product.

GR20-16EMPL Digital Input and
Output Module User Guide

PS00007356 Introduces the product information, mechanical
installation, and electrical installation of the
product.

GS20-16EMNL Digital Input and
Output Module User Guide

PS00009314 Introduces the product information, mechanical
installation, and electrical installation of the
product.

GS20-16EMPL Digital Input and
Output Module User Guide

PS00009714 Introduces the product information, mechanical
installation, and electrical installation of the
product.

GS20-16EMNL-S Digital Input and
Output Module User Guide

PS00018165 Introduces the product information, mechanical
installation, and electrical installation of the
product.

GS20-16EMPL-S Digital Input and
Output Module User Guide

PS00018166 Introduces the product information, mechanical
installation, and electrical installation of the
product.

GS20-EIP-8L High Protection IO-
Link Master Module User Guide
(This guide)

PS00018182 Introduces the product information, mechanical
installation, electrical installation, programming
commissioning, and troubleshooting of the
product.

Revision History

Date Version Revision
July 2025 A01 Made minor corrections.

January 2025 A00 Initial release.

Access to the Guide

This guide is not delivered with the product. You can obtain the PDF version in the following ways

● Do keyword search under Service and Support at www.inovance.com.
● Scan the QR code on the product with your smart phone.
● Scan the QR code below to install My Inovance app, where you can search for and download user

guides.

Warranty Disclaimer

Inovance provides warranty service within the warranty period (as specified in your order) for any fault
or damage that is not caused by improper operation of the user. You will be charged for any repair
work after the warranty period expires.

Within the warranty period, maintenance fee will be charged for the following damage:

● Damage caused by operations not following the instructions in the user guide
● Damage caused by fire, flood, or unusual voltage
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● Damage caused by unintended use of the product
● Damage caused by use beyond the specified scope of application of the product
● Damage or secondary damage caused by force majeure (natural disaster, earthquake, and lightning

strike)

The maintenance is charged according to the latest Price List of Inovance. If otherwise agreed upon,
the terms and conditions in the agreement shall prevail.

For details, see Product Warranty Card.
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Safety Instructions

Safety Disclaimer

1. Read and follow the safety instructions when installing, operating, and maintaining the equipment.
2. To ensure your safety and prevent damage to the equipment, follow the marks on the equipment

and all the safety instructions in this guide.
3. "CAUTION", "WARNING", and "DANGER" items in this guide do not indicate all safety precautions

that need to be followed; instead, they just supplement the safety precautions.
4. Use this equipment according to the designated environment requirements; otherwise, a fault may

occur. Malfunction or damage caused by improper use is not covered by warranty.
5. Inovance shall take no responsibility for any personal injury or property damage caused by improper

use.

Safety Levels and Definitions

 
"DANGER" indicates that failure to comply with the notice will result in death or severe personal
injuries.

 
"WARNING" indicates that failure to comply with the notice may result in death or severe
personal injuries.

 
"CAUTION" indicates that failure to comply with the notice may result in minor or moderate
personal injury or equipment damage. Keep this user guide properly for future use and deliver it
to the end user.

Control System Design

 

● Provide a safety circuit outside the PLC so that the control system can still work safely once external
power failure or controller fault occurs.
● Add an external fuse or circuit breaker to prevent the module from smoking or catching fire due to
long-time overcurrent caused by operation above rated current or load short-circuit.

 

● An emergency stop circuit, a protection circuit, a forward/reverse operation interlocked circuit, and
an upper position limit and lower position limit interlocked circuit must be set in the external circuits
of PLC to prevent damage to the equipment.
● To ensure safe operation, for the output signals that may cause critical accidents, use external
protection circuit and safety mechanism.
● Once the CPU of the PLC detects an exception in the system, all outputs may be closed; however,
when a fault occurs in the controller circuit, the output may not be under control. Therefore, it is
necessary to design an appropriate external control circuit to ensure normal operation.
● If the output units such as relays or transistors are damaged, the output may fail to switch between
ON and OFF states according to the commands.
● The PLC is designed to be used in an indoor electrical environment compliant with overvoltage
category II. The power supply must have a system-level surge protector to ensure that overvoltage
caused by lightning shock cannot be applied to power supply input terminals, signal input terminals,
and control output terminals of the PLC, therefore preventing damage to the product.

Safety Instructions
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Installation

 

● Installation must be carried out by skilled personal who have undergone specialized electrical
training and possess comprehensive electrical expertise.
● Disconnect all external power supplies of the system before installing/removing the module. Failure
to do so may result in electric shock, module fault, or malfunction.
● Do not use the PLC in environments with dust, greasy smoke, conductive dust, corrosive or
combustible gases, exposed to high temperature, condensation, wind & rain, or subject to vibration
and shock. Electric shock, fire, and malfunction may also result in damage or deterioration to the
product.
● The PLC is open-type equipment that must be installed in a control cabinet with lock (cabinet
housing protection > IP20). Only the skilled personnel who have undergone specialized electrical
training and possess comprehensive electrical expertise can open the cabinet.

 

● Prevent metal filings and wire ends from dropping into ventilation holes of the PLC during
installation. Failure to comply may result in fire, fault, and malfunction.
● Ensure there are no unwanted matters on ventilation surface. Failure to comply may result in poor
ventilation, which may cause fire, fault, or malfunction.
● Ensure the module is connected to the respective connector securely and hook the module firmly.
Improper installation may result in malfunction, fault or fall-off.
● Ensure natural ventilation for the equipment.

Wiring

 

● Wiring must be carried out by skilled personnel who have undergone specialized electrical training
and possess comprehensive electrical expertise.
● Disconnect all external power supplies of the system before wiring. Failure to comply may result in
electric shock, module fault, or malfunction.
● After wiring, install the terminal cover attached to the product before power-on or operation.
Failure to comply may result in electric shock.
● Insulate the cable terminals properly to ensure the insulation distance between cables will not be
shortened after cables are connected to the terminal block. Failure to comply may result in electric
shock or damage to the product.

 

● To avoid electric shock, cut off the power supply before connecting the equipment to the power
supply.
● The input power supply of this product must be 24 VDC. Power supplies outside ±20％ of 24 VDC
can cause severe damage to the product. Therefore, check whether the DC power supply provided by
the switching-mode power supply is stable at a regular interval.

Safety Instructions
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Operation and maintenance

 

● Operation and maintenance must be carried out by skilled personnel who have undergone
specialized electrical training and possess comprehensive electrical expertise.
● Do not touch the terminals while the power is on. Failure to comply may result in electric shock or
malfunction.
● Disconnect all external power supplies of the system before cleaning the module or re-tightening
screws on the terminal block or the connector. Failure to comply may result in electric shock.
● Disconnect all external power supplies of the system before assembling/disassembling the module
or connecting/removing the communication cables. Failure to comply may result in electric shock or
malfunction.
Safety Recommendations

● In the position where the operator directly touches the machinery part, for example, where a
machinery tool is loaded/unloaded, or where a machine runs automatically, the on-site manual
operating devices and any other alternative means must be carefully arranged and designed so that
they are independent of the PLC and can start or terminate the automatic running of the system.
● If modification on the program is needed during system operation, use the lock function or other
protective measures. Ensure that only authorized personnel can make the necessary modifications.

Disposal

 

● Treat the scrapped product as industrial waste. Dispose of the battery according to local laws and
regulations.
● Recycle retired equipment by observing industry waste disposal standards to avoid environmental
pollution.

Safety Instructions
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1 Product Information

1.1 Functions

Basic functions

● IO-Link communication

■ IO-Link master that can communicate with the IO-Link V1.0 and V1.1 devices
■ Equipped with eight IO-Link ports to connect up to eight IO-Link devices (Class A type)

● Ethernet/IP communication
Equipped with two EtherNet/IP network ports (M12-D type) to transfer data between IO-Link
devices and EtherNet/IP devices

● Parameter configuration

■ Device parameter modification: The system supports modifying the operation parameters of the
slave devices through UCMM communication.

■ Port parameter backup: When this function is enabled, the system automatically backs up the
configuration parameters of the slave connected to the port for the first time, and the slave
connected to the port will run according to this backup parameter.

● Port mode configuration

■ Standard IO-Link master mode
■ Standard digital input mode
■ Standard digital output mode

● Visualized diagnosis

■ Network connection indicator
■ EtherNet/IP communication state indicator
■ US/UA power supply voltage state indicator
■ I/O-LINK port communication state indicator (indicating faults, short circuit, and overcurrent)

Digital input and output function

● Equipped with 16 configurable DI/DOs
● Pin2 and Pin4 of each port can be configured as DI/DO mode.
● The reference potential of all inputs and outputs is Pin3 voltage.

IO-Link port function

● Equipped with eight IO-Link device power supplies
● Class-A IO-Link ports
● Short circuit detection for the power supply of each port
● Short circuit/overcurrent protection for Pin1, Pin2 (DO mode), and Pin4 (DO mode)
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1.2 Naming Rules and Nameplate

① Product Family

G: Inovance controller general-purpose module

④ Communication Protocol

ECT: EtherCAT bus communication

EIP: EtherNet/IP communication

PN: PROFINET communication
② Product Type

S: High protection

⑤ Number of Converter Channels

8: Eight channels

③ Series

20: 20 series

⑥ Module Type

L: IO-Link

The data for ordering the product is shown in the following table.

Model Description Material Code Applicable Model
GS20-EIP-8L GS20 series high protection master

module that transfers EtherNet/IP
communication to eight channels of IO-
Link communication

01440656 Class A IO-Link master
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1.3 Components
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No. Name Description

① State indicator Link Network
connection
indicator

● Solid ON in green: The module is connected to
the peer device.
● OFF: The module is not connected to the peer
device, or the module or the peer device is not
powered on.

ACT Data transmission
indicator

● Flashing in yellow: Data transmission in progress
● OFF: No data transmission

US System power
supply indicator

● Solid ON in green: The US power supply voltage is
normal (18 VDC ≤ US power supply voltage ≤ 30.2
VDC).
● Solid ON in red: The US power supply voltage is
abnormal (US power supply voltage > 30.2 VDC).
● Flashing in red[2]: The US power supply voltage is
abnormal (11 VDC < US power supply voltage < 18
VDC).
● Flashing in red[1]: The US power supply voltage is
abnormal (US power supply voltage < 11 VDC).
● OFF: No power supply

UA Actuator power
supply indicator

● Solid ON in green: The UA power supply voltage is
normal (18 VDC ≤ UA power supply voltage ≤ 30.2
VDC).
● Solid ON in red: The UA power supply voltage is
abnormal (UA power supply voltage > 30.2 VDC).
● Flashing in red[2]: The UA power supply voltage is
abnormal (11 VDC ≤ UA power supply voltage ≤
18 VDC).
● OFF: The UA power supply voltage is abnormal
(UA power supply voltage < 11 VDC).

MS Module state ● Solid ON in green: The module is operating
normally.
● Flashing in green: The module restores factory
settings.
● Flashing in red: The module hardware is faulty
(abnormal US/UA/temperature).

NS Network state ● OFF: The communication is not established.
● Solid ON in red: IP address conflict occurs.
● Solid ON in green: The proprietary owner
connection is normal.
● Flashing in green: The proprietary owner
connection does not exist or is offline.
● Flashing in red and green alternatively: The
proprietary owner connection and the input-only
connection are offline.
● Flashing in red: The input-only connection is
offline.

NET Communication
indicator

Solid ON in green: EtherNet/IP communication
mode

Solid ON in red: Abnormal network startup

For details, see the NET indicator state table.

② EtherNet/IP
communica-
tion interface

IN Used for EtherNet/IP communication input and output. For pin
assignment, see “3.3 Terminal Definition” on page 20OUT
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No. Name Description

③ DIP switch ID/IP Slave address setting switch (value range: 0 to 255)

×16/×1: Slave address code plate switch set in hexadecimal format.

The value of the x16 DIP switch represents the high 4 bits and the value
of the x1 DIP switch represents the low 4 bits. The DIP switch is
converted to decimal address as (value corresponding to the x16 DIP
switch) * 16 + (value corresponding to the x1 DIP switch) * 1.

Example: When the x16 DIP switch is set to A (A = 10 in hexadecimal) and
the x1 DIP switch is set to E (E = 14 in hexadecimal),

the last byte of the IP address is set to 0×AE,

and the corresponding decimal address is 10*16 + 14 = 174.

④ Power supply
interface

POWER IN Used for power supply input/output. For pin assignment, see “3.3
Terminal Definition” on page 20POWER

OUT
⑤ IO-Link

indicator
0 Indicator 0 ● Solid ON in yellow: The output state of Pin4 is 1.

● Solid ON in green: The IO-Link communication is
connected or the input state of Pin4 is 1.
● Flashing in green[2]: The IO-Link communication is
not connected.
● Solid ON in red: Pin4 encounters overcurrent.
● Flashing in red and green alternatively: The IO-
Link communication is not connected due to
invalid verification.
● Flashing in red[2] (together with indicator 1): Pin1
encounters overcurrent.
● OFF: The input/output state of Pin4 is 0.

1 Indicator 1 ● Solid ON in yellow: The output state of Pin2 is 1.
● Solid ON in green: The input state of Pin2 is 1.
● Solid ON in red: Pin2 encounters overcurrent.
● Flashing in red[2] (together with indicator 0): Pin1
encounters overcurrent.
● OFF: The input/output state of Pin2 is 0.

⑥ IO-Link port 0/1/2/3/4/
5/6/7

Used for I/O-Link data transmission. For pin assignment, see “3.3
Terminal Definition” on page 20

⑦
Grounding
terminal

During installation, ensure that the protective grounding terminal of the
module is grounded properly, with a recommended grounding
impedance of less than 1 Ω.

Note
● Flashing: The indicator is on for 200ms and off for 200ms, repeating this cycle.
● [1]: US/UA indicator is on for 250ms and off for 250ms, repeating this cycle.
● [2]: The IO-Link indicator and US/UA indicator is on for 500ms and off for 500ms, repeating this cycle.

: High temperature caution for the module.

The following table introduces the specific states of the NET indicator.
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Input Connection/
Proprietary Owner

Connection

The proprietary owner
connection does not exist

The proprietary owner
connection exists and is

online

The proprietary owner
connection exists but is

offline
Input only connection
does not exist

Green indicator OFF

Red indicator OFF

Solid ON in green

Red indicator OFF

Flashing in green

Red indicator OFF
Input only connection
exists and is online

Flashing in green

Red indicator OFF

Solid ON in green

Red indicator OFF

Flashing in green

Red indicator OFF
Input only connection
exists but is offline

Green indicator OFF

Flashing in red

Solid ON in green

Flashing in red

Flashing in green

Flashing in red

1.4 Technical Specifications

General specifications
Item Specification

Dimensions (W x H x D) 69.8 mm x 224.8 mm x 20.5 mm

Weight About 550 g

Power supply specifications

Item Specification

Rated voltage of US power supply 24 VDC (18 VDC to 30.2 VDC)

Maximum current of US power supply The maximum input/output current is 9 A (with the external
+24 V power supply disabled for IO-Link port).

US reverse polarity protection Supported

Rated voltage of UA power supply 24 VDC (18 VDC to 30.2 VDC)

Maximum current of UA power supply The maximum input/output current is 9 A (with the DO
disabled).

UA reverse polarity protection Supported

US undervoltage detection The module uses software to perform undervoltage detection
(< 18 VDC), voltage-loss detection (< 11 VDC), and overvoltage
detection (≥ 30.2 VDC).

UA undervoltage detection The module uses software to perform undervoltage detection
(< 18 VDC), voltage-loss detection (< 11 VDC), and overvoltage
detection (≥ 30.2 VDC).

Input specifications
Item Specification

Input type Digital input

Input mode PNP

Maximum number of input channels 16

Input voltage 24 VDC (18 VDC to 30.2 VDC)

Input current (typical value) 2.4 mA (typical value @24 V)

ON voltage > 11 VDC

Signal OFF voltage < 5 VDC

Hardware response time upon ON/OFF 100μs (Max.)/100μs (Max.)
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Item Specification

Supported type Type1/Type3

Isolation Not supported

Output specifications

Item Specification
Output type Digital output/transistor output

Output mode PNP

Maximum number of output channels 16

Output voltage 24 VDC (18 VDC to 30.2 VDC)

Resistive output load 2 A/channel; 9 A/module

Inductive output load 24 W/point

Lamp output load 18 W/point

Hardware response time upon ON/OFF 100μs (Max.)/1.4ms (Max.)

Leakage current upon OFF 10 μA (with 24 VDC)

Isolation Not supported

Protective functions Short circuit protection

Output derating ● Outside the cabinet: The module works at full load at
70°C. For example, the output current of the 16-
channel resistive output load does not exceed 9 A.
● Inside the cabinet: The module works at 75% of full
load at 70°C. For example, the output current of the
16-channel resistive output load does not exceed 7 A.

IO-Link specifications

Item Specification

Number of ports 8

IO-Link version 1.1.3
IO-Link port type Class A

Communication rate COM1 (4.8 kbps)

COM2 (38.4 kbps)

COM3 (230.4 kbps)

Process data volume Max. 32 bytes of input data of each port.

Max. 32 bytes of output data of each port.

Capacity of the memory for device parameters 2 kbyte (applicable to each port)

External +24 V "L+" supply current of IO-Link port
(Pin1)

Rated current: 1.6 A

Overcurrent protection value: 2 A

Isolation method Not supported

Unshielded cable length Max. 20 m

Cable requirements 5-pin unshielded cable

Protective functions Overcurrent protection
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EtherNet specifications
Item Specification

Number of communication interfaces 2
IP setting method BOOTP/DHCP

Network topology Linear, star, tree, and DLR (only supported as managed)

Maximum data length Input: 392 bytes

Output: 262 bytes

Transmission distance 100 m
RPI time 1ms to 50,000ms

Maximum number of CIP connections 16
Network interface Two M12 D-code interfaces with switching function

Connection rate 100 M
Restore factory settings Supported

1.5 Environmental Specifications

Item Operating Specification Transportation
Specification

Storage
Specification

IP rating IP67 (with screws tightened)

Pollution degree 2

Immunity 2 kV on power supply line (IEC61000-4-4)

Overvoltage class I

EMC immunity level Zone B, IEC61131-2

ESD protection
level

Contact discharge +/-6 kV, air discharge +/-8 kV

Temperature -30°C to +70°C -40°C to +85°C -40°C to +85°C

Humidity 10% RH to 99% RH, without condensation

100% (when all connectors are installed)

Vi-
bra-
tion

Frequency 5 Hz to 500 Hz

2M2 1M12

Displace-
ment

1 mm (direct installation) (5 Hz to 61 Hz)

Acceleration
rate

15 g (direct installation) (61 Hz to 500 Hz)

Direction X/Y/Z directions
Shock resistance Application/Transportation scenario:

Tested according to IEC60068-2-27; 15 g
peak gravitational acceleration, 11 ms
pulse width, total 18 times in X/Y/Z
directions

Altitude/Air
pressure

0 m to 2000 m (> 79.5 kPa) 0 m to 2000 m (> 79.5 kPa)
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2 Mechanical Installation

2.1 Installation Dimensions

The installation dimensions (in mm) are shown in the figure below.

2.2 Installation Method

Installation

Install the module with two cross recessed hexagon SEMS screws (M6 x 25) with the washer diameter
of 11 mm. The clearance between the two screws is 209.4 mm. The following figure describes the
installation and clearance (in mm).

Uninstallation

Remove the M6 screws using a Phillips screwdriver, and then detach the module.
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3 Electrical Installation

3.1 IO-Link Topology

I/O-Link is a serial digital communication protocol that integrates intelligent sensors and actuators
into automation systems. It is the first standardized I/O technology (IEC 61131-9) used for
communication of sensors and actuators. It is used for periodic data exchange between the sensor/
actuator and the PLC. IO-Link is not a fieldbus, but an open point-to-point communication. This
protocol is easy to use, stable, and reliable. With the advancement of Industry 4.0, it is gaining wider
adoption.

The IO-Link topology consists of the PLC, IO-Link master (GS20-EIP-8L), IO-Link slave (GR20-16EMNL/
GR20-16EMPL/GS20-16EMNL/GS20-16EMPL/GS20-16EMNL-S/GS20-16EMPL-S), sensor/actuator, and IO-
Link cables. IO-Link masters communicate with PLCs and other IO-Link masters via EtherNET/IP. IO-
Link communication is adopted for connection between IO-Link masters and IO-Link slaves/sensors/
actuators, as well as IO-Link slaves and sensors/actuators. IO-Link masters and slaves can directly
power sensors and actuators. The IO-Link topology is shown in the figure below.

Note
The IO-Link port supports two operating modes: IO-Link mode and SIO mode (Standard I/O mode), which can be
separately configured on any port.

3.2 Cable Selection

Ethernet/IP communication cable

The data for ordering the Ethernet/IP communication cable is as follows.
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Model Description Lengt
h

Material
Code

CAB-M12DMS4-M12DMS4-3
Cable assembly - Ethernet/IP cable - Male (straight)
- 22AWG - Green - Male (straight) - 80°C (cables for
cascading multiple IO-Link masters (Ethernet/IP
cascaded))

3 m 15310153
CAB-M12DMS4-M12DMS4-5 5 m 15310178
CAB-M12DMS4-M12DMS4-8 8 m 15310221
CAB-M12DMS4-M12DMS4-10 10 m 15310177
CAB-M12DMS4-M12DMS4-15 15 m 15310176
CAB-RJ45-M12DMS4-3

Cable assembly - Ethernet/IP cable - Male (straight)
- 26 AWG - Black - RJ45 - 80°C (used for connecting
PLC network ports and IO-Link masters)

3 m 15310154
CAB-RJ45-M12DMS4-5 5 m 15310187
CAB-RJ45-M12DMS4-8 8 m 15310215
CAB-RJ45-M12DMS4-10 10 m 15310186
CAB-RJ45-M12DMS4-15 15 m 15310185

Power supply input cable

The data for ordering the power supply input cable is as follows.

Model Description Lengt
h

Material
Code

CAB-7/8FL5-3

Cable assembly - 7/8" power supply cable - Female
(angled) - 16 AWG - Black - NA - 80°C (used for
powering IO-Link masters)

3 m 15310155
CAB-7/8FL5-5 5 m 15310175
CAB-7/8FL5-8 8 m 15310216
CAB-7/8FL5-10 10 m 15310174
CAB-7/8FL5-15 15 m 15310173

The following table introduces the functions of power supply cables in different colors.

No. Color Function
1 Black 0V
2 Blue 0V
PE Green/Yellow Function grounding

4 Brown Sensor and power supply system (US)
5 White Power supply of the actuator (UA)

Power supply input cable

The data for ordering the power supply input cable is as follows.

Model Description Lengt
h

Material
Code

CAB-7/8FL5-3

Cable assembly - 7/8 power supply cable - Female
(angled) - 16 AWG - Black - NA - 80°C (used for
powering IO-Link masters)

3 m 15310155
CAB-7/8FL5-5 5 m 15310175
CAB-7/8FL5-8 8 m 15310216
CAB-7/8FL5-10 10 m 15310174
CAB-7/8FL5-15 15 m 15310173

The following table introduces the functions of power supply cables in different colors.

No. Color Function
1 Black 0V
2 Blue 0V
PE Green/Yellow Function grounding
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No. Color Function
4 Brown Sensor and power supply system (US)
5 White Power supply of the actuator (UA)

Power supply output cable

The data for ordering the power supply output cable is as follows.

Model Description Lengt
h

Material
Code

CAB-7/8FL5-7/8ML5-3
Cable assembly - 7/8 power supply cable -
Female (angled) - 16 AWG - Black - Female
(angled) - 80°C (used for cascading multiple
IO-Link master power supplies)

3 m 15310156
CAB-7/8FL5-7/8ML5-5 5 m 15310181
CAB-7/8FL5-7/8ML5-8 8 m 15310219
CAB-7/8FL5-7/8ML5-10 10 m 15310180
CAB-7/8FL5-7/8ML5-15 15 m 15310179

IO-Link communication cable

The data for ordering IO-Link communication cable is as follows:

Model Description Lengt
h

Material
Code

CAB-M12AMS4-M12AFL4-3
Cable assembly - IO-Link cable - Male
(straight) - 22AWG - Black - Female (angled)
- 85°C (used for connecting the IO-Link
master to IO-Link slaves)

3 m 15310142
CAB-M12AMS4-M12AFL4-5 5 m 15310184
CAB-M12AMS4-M12AFL4-8 8 m 15310230
CAB-M12AMS4-M12AFL4-10 10 m 15310183
CAB-M12AMS4-M12AFL4-15 15 m 15310182
CAB-M12AMS4-M12AFL4-3-T-taiyo Cable assembly - IO-Link cable - Male

(straight) - 22AWG - Black - Female (angled)
- 85°C - Highly flexible cables fit for drag
chains, surviving 3 to 5 million continuous
tests (used for connecting the IO-Link
master to IO-Link slaves)

3 m 15310232
CAB-M12AMS4-M12AFL4-5-T-taiyo 5 m 15310231
CAB-M12AMS4-M12AFL4-8-T-taiyo 8 m 15310229
CAB-M12AMS4-M12AFL4-10-T-taiyo 10 m 15310228
CAB-M12AMS4-M12AFL4-15-T0-taiyo 15 m 15310227

Plug and connector assembly

The data for ordering the plug and connector assembly is as follows:

Model Description Material
Code

CON-M12AFS4 4-pin female (straight) field-wirable plug 15051155

CON-M12AFL4 4-pin female (angled) field-wirable plug 15051157

CON-M12AMS5 5-pin male (straight) field-wirable plug 15051156

CON-M12AML5 5-pin male (angled) field-wirable plug 15051158

CON-M12AMS5-YF5
Y splitter that converts one 5-pin male M12
connector to two 5-pin female M12 DIO connectors 15051159

CON-M12AFL4-L
4-pin female (angled) field-wirable plug (applicable
to GR20-16EMNL/GR20-16EMPL) 15051269

CON-M12AMS4-YM8F3
Y splitter that converts one M12 5-pin A-code male
straight connector to two M8 3-pin female
connectors

15051420
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Model Description Material
Code

CON-M12AMS4-YM8F4
Y splitter that converts one M12 5-pin A-code male
straight connector to two M8 4-pin female
connectors

15051419

CON-M8AMS3 M8 3-pin assembled connector 15051445

CON-M8AMS4 M8 4-pin assembled connector 15051448
CON-M12AFS5-YM5 Y splitter that converts one 5-pin female connector

to two 5-pin male straight connectors. It can be
used to connect the class A master to class B valve
terminal slave.

15051334

IPT210-A-CAB-M12AMS5-M12AFS5-1.5 Connector that converts 5-pin male straight
connector to 5-pin female straight connector. It can
be used to connect the IO-Link master to valve
terminal.

72235829

IPT210-A-CAB-M12AFS5-1.5 Connector that converts 5-pin female straight
connector to discrete cable. It can be used to power
the valve terminal.

72235870

Note
If you have additional requirements for cable selection, contact Inovance for customization.

3.3 Terminal Definition

Assignment of EtherNet/IP pins

Diagram Pin Description

1 TD+
2 RD+
3 TD-
4 RD-

Assignment of power supply input pins

Diagram Pin Description

1 0V
2 0V
3 Function grounding (PE)

4 Sensor and system power supply
(US)

5 Actuator power supply (UA)
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Assignment of power supply output pins

Diagram Pin Description

1 0V
2 0V
3 Function grounding (PE)

4 Sensor and bus power supply (US)

5 Actuator power supply (UA)

Assignment of IO-Link pins

Diagram Pin Func
tion

Description Color

1 L+ +24 V power supply (US+) Brown

2
I/Q

● Not connected (Class A)
● DI: Digital input (Class A)
● DO: Digital output (Class A) White

2L+ +24 V power supply (UA+)

3 L- +24 V power supply (US-) Blue

4 C/Q ● SIO: Standard input/output mode
● IO-Link communication mode Black

5
NC Not connected (Class A)

Undefined
2L- +24 V power supply (UA-)

3.4 Terminal Wiring
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4 Program Commissioning

4.1 IP Address Configuration and Definition

Configure the IP address to establish communication between the PLC and the module. The factory
default IP address information is shown below.

● IP address: 192.168.1.66
● Subnet mask: 255.255.255.0
● Gateway address: 192.168.1.1

Configuring the IP address via DIP switch

The GS20-EIP-8L module is equipped with three DIP switches, defined as follows:

● When the ID/IP value of the DIP switch is 0x00, the default IP address (192.168.1.66) is used.
● When the ID/IP value of the DIP switch is within the range of 0x01 to 0xFE, this value represents the

last byte of the IP address, which is 192.168.1.(ID/IP value).
● When the ID/IP value of the DIP switch is 0xFF, the device defaults to the DHCP mode.

To reset the DIP switch, power off the module and set the DIP switch to 6FF, as shown below.

Power on the module and set the DIP switch to 400, as shown below. Power off and on the module
again, the IP address of the module will be restored to default (192.168.1.66). After modifying the IP
address, it is necessary to power off and restart the GS20-EIP-8L module.

4.2 GS20-EIP-8L Module Parameter Configuration

4.2.1 Configuration Data

The following table introduces the parameter configuration of the GS20-EIP-8L module, including the
sizes of input, output, and configuration data.

Name Instance ID Data Length

Input port 110 392
Output 100 262

Configuration 120 194
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The following table introduces the configuration parameter sequence of the GS20-EIP-8L module.
Bytes 0 to 9 are for basic module configuration, including port functions and output state upon
network disconnection. Bytes 10 to 193 are for IO-Link configuration of the eight ports.

Byte Configuration Object Description

0 to 9 Module Basic configuration of the whole
module

10 to 32 IO-Link port 0 Configuration of IO-Link port 0

33 to 55 IO-Link port 1 Configuration of IO-Link port 1

56 to 78 IO-Link port 2 Configuration of IO-Link port 2

79 to 101 IO-Link port 3 Configuration of IO-Link port 3

102 to 124 IO-Link port 4 Configuration of IO-Link port 4

125 to 147 IO-Link port 5 Configuration of IO-Link port 5

148 to 170 IO-Link port 6 Configuration of IO-Link port 6

171 to 193 IO-Link port 7 Configuration of IO-Link port 7

The following table introduces the basic configuration of the entire module. The port function can be
configured to use the Pin4 of each port as IO-Link or as standard I/O. If Pin4 is used as standard I/O, the
port function can be configured as NO (normally open) input, NC (normally closed) input, or output
mode.

● Configured as standard I/O
Output state upon network disconnection of Pin2/Pin4: When the network is disconnected, the
module can be configured to output 0 V, 24 V, or the last cycle value.

The Pin2 port function can be configured as NO input, NC input, output mode, or output enable
mode. When it is configured as output enable, Pin2 output can be achieved without modifying the
output process data through I/O mapping.

The Pin4 port function can be configured as NO input, NC input, or output mode.

Byte Bit Description
- 7 6 5 4 3 2 1 0 -
0 Port 3 Port 2 Port 1 Port 0 Port function (port_

function)

● 0x00: Standard I/O
● 0x01: IO-Link

1 Port 7 Port 6 Port 5 Port 4

2 Port 3 to Pin2 Port 2 to Pin2 Port 1 to Pin2 Port 0 to Pin2 Pin2 output function
upon network
disconnection

(Pin2_safe_state)

● 0x00: Output 0 V
● 0x01: Output 24 V
● 0x02: Output the last
cycle value

3 Port 7 to Pin2 Port 6 to Pin2 Port 5 to Pin2 Port 4 to Pin2
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Byte Bit Description
4 Port 3 to Pin4 Port 2 to Pin4 Port 1 to Pin4 Port 0 to Pin4 Pin4 output function

upon network
disconnection

(Pin4_safe_state)

● 0x00: Output 0 V
● 0x01: Output 24 V
● 0x02: Output the last
cycle value

5 Port 7 to Pin4 Port 6 to Pin4 Port 5 to Pin4 Port 4 to Pin4

6 Port 3 to Pin2 Port 2 to Pin2 Port 1 to Pin2 Port 0 to Pin2 Pin2 port function

(Pin2_fun)

● 0x00: NO input
● 0x01: NC input
● 0x02: Output mode
● 0x03: Output enable

7 Port 7 to Pin2 Port 6 to Pin2 Port 5 to Pin2 Port 4 to Pin2

8 Port 3 to Pin4 Port 2 to Pin4 Port 1 to Pin4 Port 0 to Pin4 Pin4 port function

(Pin4_fun)

● 0x00: NO input
● 0x01: NC input
● 0x02: Output mode

9 Port 7 to Pin4 Port 6 to Pin4 Port 5 to Pin4 Port 4 to Pin4

Configured as IO-Link port

The following table introduces the IO-Link port configuration details.

Byte Bit Description
- 7 6 5 4 3 2 1 0 -
10 Time base Scaling factor Cycle time configuration

11 Port verification mode ● 0: Disable
● 1: V1.0 verification for
Vendor/Device ID
● 2: V1.1 verification for
Vendor/Device ID
● 3: Enable slave
configuration parameter
backup and restoration
● 4: Enable slave
configuration parameter
restoration
Note:

● V1.0 and V1.1 indicate
the IO-Link slave protocol
stack versions.
● When using modes 3
and 4, the port must be
configured as
configuration mode.

12 Vendor ID0 (VID) Vendor ID
13 Vendor ID1 (VID)
14 Device ID0 (DID) Slave device ID
15 Device ID1 (DID)
16 Device ID2 (DID)
17 Serial number 0 (Sernum) Device serial number
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Byte Bit Description
... ... ...
32 Serial number 16 (Sernum) -

... The data structure of the other serial numbers is the same. -

The cycle time configuration can affect the IO-Link communication speed. The calculation is based on
multipliers and time bases as described in the following table. When the cycle time is set to
"automatic", the IO-Link master automatically the update time of the IO-Link device.

Bit Description
7 6 5 4 3 2 1 0 -
Time base Multiplier ● Bits 0 to 5 represent the

multiplier, which contains a 6-
digit multiplier used to
calculate MasterCycleTime or
MinCycleTime. The multiplier
range is 0 to 63.
● Bits 6 to 7 represent the time
base, which specifies the time
base for MasterCycleTime or
MinCycleTime calculations.

The optional values of MasterCycleTime and MiniCycleTimecycle are shown in the following table.

Time Base Code Time Base Value Calculation Method Cycle Time

00 0.1ms Multiplier x Time base 0.4ms to 6.3ms

01 0.4ms 6.4ms + Multiplier x Time base 6.4ms to 31.6ms

10 1.6ms 32.0ms + Multiplier x Time base 32.0ms to 132.8ms

11 Reserved Reserved Reserved

4.2.2 Input Process Data

The size of the input data is 392 bytes. The allocation of the process data input is shown in the
following table.

Byte Configuration Object Note

0 to 7 Standard I/O port Process data input for standard input

8 to 55 IO-Link port 0 Process data input for IO-Link port 0

56 to 103 IO-Link port 1 Process data input for IO-Link port 1

104 to 151 IO-Link port 2 Process data input for IO-Link port 2

152 to 199 IO-Link port 3 Process data input for IO-Link port 3

200 to 247 IO-Link port 4 Process data input for IO-Link port 4

248 to 295 IO-Link port 5 Process data input for IO-Link port 5

296 to 343 IO-Link port 6 Process data input for IO-Link port 6

344 to 391 IO-Link port 7 Process data input for IO-Link port 7

● Input process data for standard I/O input
Bytes 0 to 7 represent the input process data when the port is configured as standard input, as
shown in the table below.
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Byte Bit Note
- 7 6 5 4 3 2 1 0 -
0 I32 I34 I22 I24 I12 I14 I02 I04 Input data

● I02: Input data of
Pin2 of port 0
● I04: Input data on
Pin4 of port 0

1 I72 I74 I62 I64 I52 I54 I42 I44

2 S3 S2 S1 S0 Short circuit state

Short circuit between
Pin1 and Pin3

3 S7 S6 S5 S4

4 O32 O3-
4

O22 O24 O12 O14 O02 O04 Overload state

● O04: Pin4 of port 0
is overloaded
● O02: Pin2 of port 0
is overloaded

5 O72 O7-
4

O62 O64 O52 O54 O42 O44

6 - T US UA System state

● UA: UA power
supply state
● US: US power
supply state
● T: Temperature
state

● 00: -30°C <
Internal
temperature <
85°C
● 01: Internal
temperature <
-30°C
● 10: Internal
temperature >
85°C
● 11: Reserved

● 00: 18 VDC < US <
30.2 VDC
● 01: 11 VDC < US <
18VDC
● 10: US > 30.2 VDC
● 11: US < 11 VDC

● 00: 18 VDC < UA
< 30.2 VDC
● 01: 11 VDC < UA
< 18 VDC
● 10: UA > 30.2
VDC
● 11: UA < 11 VDC

7 0 0 0 0 0 0 0 0 Reserved

● Input process data for IO-Link port
Bytes 8 to 391 represent the input process data when the port is configured as IO-Link, as shown in
the table below.
Byte Bit Note
- 7 6 5 4 3 2 1 0 -
8 to
39

- IO-Link port 0 data (IOL Ports
Inputs)

40 0 0 0 0 0 0 DC IOL IO-Link state (IOL Status)

● IOL: IO-Link mode port
● DC: Device connected
● 0: Reserved

41 0 0 0 0 0 PDI DF VF IO-Link fault (IOL Error)

● VF: Verification failed
● DF: Data storage failed
● PDI: Invalid process data

42 Vendor ID2 Vendor ID
43 Vendor ID2
44 Slave device ID1 Slave device ID
45 Slave device ID2
46 Slave device ID3
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Byte Bit Note
47 Mode Type 0 - - - Event 1

Mode

● 0: Reserved
● 1: Event single gap
● 2: Event disappeared
● 3: Event appeared
Type

● 0: Reserved
● 1: Caution
● 2: Alarm
● 3: Fault

48 High bytes of event code

49 Low bytes of event code

50 Mode Type 0 - - - Event 2

Mode

● 0: Reserved
● 1: Event single gap
● 2: Event disappeared
● 3: Event appeared
Type

● 0: Reserved
● 1: Caution
● 2: Alarm
● 3: Fault

51 High bytes of event code

52 Low bytes of event code

53 Mode Type 0 - - - Event 3

Mode

● 0: Reserved
● 1: Event single gap
● 2: Event disappeared
● 3: Event appeared
Type

● 0: Reserved
● 1: Caution
● 2: Alarm
● 3: Fault

54 High bytes of event code

55 Low bytes of event code

... The data structure of IO-Link port is the same. -

4.2.3 Output Process Data

The size of the output data is 262 bytes. The allocation of the output process data is shown in the
following table.

Byte Configuration Object Note

0 to 5 Standard I/O port Process data output of standard
output

6 to 37 IO-Link port 0 Process data output for IO-Link port
0

38 to 69 IO-Link port 1 Process data output for IO-Link port
1

70 to 101 IO-Link port 2 Process data output for IO-Link port
2
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Byte Configuration Object Note

102 to 133 IO-Link port 3 Process data output for IO-Link port
3

134 to 165 IO-Link port 4 Process data output for IO-Link port
4

166 to 197 IO-Link port 5 Process data output for IO-Link port
5

198 to 229 IO-Link port 6 Process data output for IO-Link port
6

230 to 261 IO-Link port 7 Process data output for IO-Link port
7

● Output process data of standard output
Bytes 0 to 5 represent the output process data when the port is configured as standard output, as
shown in the table below.

Byte Bit Note
- 7 6 5 4 3 2 1 0 -
0 O32 O34 O22 O24 O12 O14 O02 O04 Output data

● O04: Output data
on Pin4 of port 0
● O02: Output data
on Pin2 of port 0

1 O72 O74 O62 O64 O52 O54 O42 O44

2 0 0 0 0 0 0 0 0 Reserved
3 0 0 0 0 0 0 0 0
4 0 0 0 0 0 0 0 0
5 0 0 0 0 0 0 0 0

● Output process data for IO-Link port
Bytes 6 to 261 represent the output process data when the port is configured as IO-Link, as shown
in the table below.

Byte Bit (0 to 7) Note

6 to 37 - Output data for IO-Link port 0
... The data structure is the same to

that of other IO-Link ports.
Output data for IO-Link port n

4.3 IO-Link Slave Parameter Configuration Through UCMM

4.3.1 ODVA EIP-Tools Connection

When the GS20-EIP-8L port is configured as IO-Link and connects to an IO-Link slave, the parameters of
the slave can be configured through the UCMM communication function.

Prerequisites

Download and install EIP-Tools from ODVA official.
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Procedure

1. Open the ODVA tool and select the same network segment as the module. If they are not in the same
network segment, configure the computer's IP address as shown below.

2. Set "Message Type" to "Broadcast" to locate the connected GS20-EIP-8L module. Click "Send List
Identity Request on UDP".

3. Click "Explicit Message" and enter related parameters for configuring the UCMM display message
issuance.
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4.3.2 IO-Link Slave Configuration Parameter Writing

The following parameters need to be configured to write IO-Link slave configuration parameters.

service class Instance Attribute
0x32 (50 in decimal) 0x96 0 to n(7) 0x02 (parameter writing)

Note
"n" refers to port number.

Enter the corresponding values in turn, as shown below.
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When configuring the entire index (with the sub-index value set to 0), the data in Data (hex) must be at least 5 bytes;
when configuring the subindex, the data in Data (hex) must be at least 4 bytes.

No. Description

① Configure parameter index, with the lower byte preceding the higher bit

② Configure parameter subindex.

③ Configure parameter data to be issued.

④ Returning “0x02” indicates successful configuration.

4.3.3 IO-Link Slave Configuration Parameter Reading

The following parameters need to be configured to read IO-Link slave configuration parameters.

Service Class Instance Attribute
0x32 (50 in decimal) 0x96 0 to n(7) 0x03 (read parameters)

Note
"n" refers to the port number.

Enter the corresponding values in turn, including the parameter index and subindex of the slave to be
read, as shown below.

No. Description

① Configure parameter index, with the lower byte preceding the higher bit

② Configure parameter subindex.

③ FF: No fault, read the corresponding configuration parameter

00: A fault occured, read the parameter fault code

④ Returning “0x02” indicates successful configuration.
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Data within Data (hex) must be greater than or equal to 2 bytes.

If there is an issue with the path being read, the "Status" will not return OK; instead, it will return the
corresponding fault code, as shown below.

Fault Code Description Solution
0x08 Service not supported Check whether the Service is correct.
0x05 Incorrect Class Check whether the Class is correct.
0x09 Incorrect Attribute Check whether the Attribute is correct.
0x20 Incorrect parameter Check whether the length of "Data" meets the

requirements.
0x02 Unavailable data source Check whether the Instance is correct and whether the

IO-Link slave is connected.

4.4 Program Commissioning

4.4.1 Programming with Inovance InoProShop

Prerequisites

● The cables are connected correctly.
● InoProShop V1.7.3 and above is installed.
● The EDS file of the GS20-EIP-8L module is imported into InoProShop. The EDS file can be obtained

under Software and Commissioning Tools on the GS20 series product page at www.inovance.com.
● EIP-Tools is downloaded and installed from ODVA official for IO-Link slave parameter configuration.

Procedure

1. Configure the EtherNet/IP network adapter.
In the "Devices" pane, double-click "EtherNet_A (EtherNet)". In the "General" tab of the pop-up
window, set "Interface" to the network adapter with the same IP as the GS20-EIP-8L module.

www.inovance.com


Program Commissioning

‑33‑

2. Add the GS20-EIP-8L module.

a. Add the EDS file.

1). In the menu bar, select "Tools" > "Device Repository" to install the EDS file.

Note
Note: If the EDS file is not installed, the GS20-EIP-8L device cannot be scanned.

2). Click "Install" and select the EDS file of the GS20-EIP-8L module to be installed.
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b. Add the GS20-EIP-8L module.

1). Add the EtherNet/IP master.
Double-click "Network Configuration" and select "EtherNet/IP Master".
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2). Add the GS20-EIP-8L module.
The module can be added through automatic scanning or manual addition.

● Automatic scanning

i. Right-click "EtherNetIPMaster_A (EtherNet/IP Scanner)" and select "Scan For Devices".
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ii. Select the scanned device and click "Scan Device".
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● Manual addition

i. Right-click "EtherNetIPMaster_A (EtherNet/IP Scanner)" and select "Add Device".

ii. Select "GS20-EIP-8L" and click "Add Device".
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3. Configure the GS20-EIP-8L module.

a. Configure the general data.
In the "Devices" pane, double-click "GS20-EIP-8L" and click "Generic". Check whether the "IP
Address" matches that of the GS20-EIP-8L module. If not, modify the "IP Address".
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b. Configuration the module data.
Click "Connection" and select the "Connection Name". Click "Configuration Data" to obtain the
configuration parameters based on the content represented by the configuration data bits. Enter
the configuration module in the corresponding configuration data. In the figure below, all port
functions are configured as IO-Link, and all Pin2 functions are configured as output mode.

c. Log in to and operate the GS20-EIP-8L module.

Click to log in and then click to operate the module. The result shown below indicates
that the operation is successful.
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d. Map the process data of GS20-EIP-8L.
Example: Configure Pin2 of all ports as outputs.

1). After logging in to InoProShop, select "GS20-EIP-8L" > "Ethernet/IP I/O Mapping". Obtain the
corresponding input parameter values in the input process data, and map the variables in the
output data or directly write output values online, as shown below.

2). Map the variables.

i. Click to log out. Right-click "Application" and select "Add Object" > "POU".



Program Commissioning

‑41‑

ii. Select the appropriate implementation language and click "Add".
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iii. Compile the program. Drag the compiled program file to the "EIPMasterServiceTask_A.
ServiceCycle" directory under "Task Configuration" to enable Pin2 outputs, as shown below.
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iv. Map the corresponding variables. In the "Ethernet/IP I/O Mapping" interface, click the "..."
button of a variable to open the pop-up "Input Assistant" window. Select the corresponding
variable and click "OK" for mapping.

v. Click to compile the program, to log in, and to download the program. In the
pop-up dialog box, click "YES" to download the program to the PLC.

vi. Click to run the program.

e. Use the GS20-EIP-8L module with an Inovance IO-Link slave.
In the following example, the GS20-EIP-8L module is used as IO-Link and an IO-Link slave is
connected.

1). Configure the software.
Based on “4.2.1 Configuration Data” on page 22, configure port 0 as IO-Link mode and configure
Pin2 of port 0 as output mode to provide UA power supply for the IO-Link slave. Log out the
PLC, modify the configuration data, and log back in to the PLC.
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2). Based on “4.2.2 Input Process Data” on page 25 and “4.2.3 Output Process Data” on page 27,
obtain the input data from the connected IO-Link slave and issue the output data.

i. Obtain the process data input (PDI) from the connected slave, including IO-Link connection
status, slave device information, and diagnostic information.

ii. Based on “4.3.2 IO-Link Slave Configuration Parameter Writing” on page 30 and “4.3.3 IO-Link
Slave Configuration Parameter Reading” on page 31, configure the parameters related to the
slave. In this example, the lower eight bits of the slave (Pin2) is configured as output and the
higher eight bits (Pin4) is configured as input.

iii. To issue the output data, refer to “4.2.3 Output Process Data” on page 27. In the "EtherNet/IP
I/O Mapping" interface, select the output process data of IO-Link "IOL Port0 Outputs[0]" and

configure the online output to 255 (16#FF). Click to enable the lower eight bits of the
slave (Pin2) as the output, as shown below.
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iv. Short one output and one input of the IO-Link slave to receive valid input data. In the
"EtherNet/IP I/O Mapping" interface, click "IOL Port0 Inputs" to obtain valid IO-Link input
process data.

4.4.2 Programming with Omron Sysmac Studio

Prerequisites

● The cables are connected correctly.
● Sysmac Studio V1.5.2 and above is installed.
● The EDS file of the GS20-EIP-8L module is imported into InoProShop. The EDS file can be obtained

under Software and Commissioning Tools on the GS20 series product page at www.inovance.com.
● EIP-Tools is downloaded and installed from ODVA official for IO-Link slave parameter configuration.

Procedure

1. Create a project.

a. Open the Sysmac Studio software and click "New Project". Select the corresponding Omron PLC
model and version, and then click "Create".

www.inovance.com
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b. Select "Controller" > "Communications Setup".

c. Select the corresponding connection type and enter the Omron host IP to perform the
communication test.

d. Set the computer to be in the same network segment as the Omron host.
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e. Click to monitor the connection status and operation mode on the right. When the PLC is

connected properly, click .

2. Import the EDS file
Right-click the right toolbox and select "Display EDS Library". In the pop-up window, click "Install"
and select the EDS file to be installed. After installation, "Inovance" is displayed in the EDS library.
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3. Configure the project.

a. Before using Omron for Ethernet/IP communication with GS20-EIP-8L, based on the input/output
data area size of GS20-EIP-8L, click "Data Types" and create the corresponding input/output data
structure as needed.

b. Click "Global Variables", and create an output variable "Output" (data type: EIP_8L_Output;
network publish: output) and an input variable "Input" (data type: EIP_8L_Input; network publish:
input), as shown below.

c. Select "Tools" > "Ethernet/IP Connection Settings". In the pop-up window, double-click the PLC to
open the "Built-in EtherNet/IP Port Settings - Connection Settings" interface.
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d. Click "Registration All" and select the input/output variables defined by the global variable. Click
"Register".
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4. Add and configure the GS20-EIP-8L module.

a. In the right "Toolbox" pane, select "Target Device" and then click "+" to add a GS20-EIP-8L
network configuration module.

b. Enter the IP address of the GS20-EIP-8L module (ensure the IP of the PLC, the IP of the network
card, and the IP of the GS20-EIP-8L are in the same network segment). Select the model name and
revision version, and click "Add".

c. Right-click the target device and select "Edit" to modify the module configuration parameters.

d. Obtain the corresponding configuration input by bit according to the module configuration
parameter description. The following example configures all ports as IO-Link.
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e. Select > . Set the target device to "192.168.1.66 GS20-EIP-8L". Set the input/output of
"Original Variable" to input/output. Set "Target Variable" to "110" for input and "100" for output.
Ensure that the target variable and originator variable have the same size (byte).

f. Click . Click or select "Controller" > "Transfer" > "To Controller...". In the pop-up
"Transfer to Controller" window, click "Execute", as shown below.



Program Commissioning

‑52‑

g. Select "View" > "Watch Tab Page". Add input/output variables in the watch window to monitor
data.
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5. Compile a program for code variable mapping.
Use programs to implement the full output of Pin2.

a. In the left "Multiview Explorer" pane, right-click "Programs" under the "POUs" directory and select
"Add" > "Ladder diagram"/"ST". Double-click "Program0" to open the programming interface.

b. Click "Variables" to open the variable interface. Select "Externals" and enter the created global
variable "Output" in the "Name" field. For details, see the corresponding Pin2 output bit in “4.2.3
Output Process Data” on page 27. Assign the output value as 43690. After programming, click the
compile button.



Program Commissioning

‑54‑

c. To add the program to tasks, click "Task Settings" in the left "Multiview Explorer" pane. Click
"Program Assignment Settings", click "+", and select "Program0".

d. Click the online button to log in to the PLC, and then click the sync button. After successful
operation, check that Pin2 of all ports of the GS2-EIP-8L module have output.
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6. Use the GS20-EIP-8L module with an Inovance IO-Link slave.
In the following example, the port 0 of the GS20-EIP-8L module is configured as IO-Link mode, which
connects to an IO-Link slave and provides UA power supply for the slave.

a. Based on “4.2.1 Configuration Data” on page 22, configure port 0 as IO-Link mode and configure
Pin2 of port 0 as output mode to provide UA power supply for the slave.

b. Click "OK". Modify the configuration parameters and delete the original connection, as shown
below.

c. Click "+" to add the target device. Enter the original variable and target variable, and click
"Transfer to Controller".
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d. In the pop-up window, select "Yes" and select "Execute the Transfer to Controller Operation in
RUN Mode", as shown below.

e. Once the configuration parameters are successfully modified and issued, select "View" > "Watch
Tab Page". Add the created global variables "Input" and "Output". Expand "Input" to obtain the
input data for IO-Link slaves connected on port 0. For details, see “4.2.2 Input Process Data” on
page 25. Obtain the connection status, device information, and diagnostic information of the
slave.
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f. Based on “4.3.1 ODVA EIP-Tools Connection” on page 28, configure the parameters related to the
slave. In this example, the lower eight bits of the IO-Link slave (Pin2) is configured as output and
the higher eight bits (Pin4) is configured as input.

g. To issue the output data, expand "Output" data in the "Watch" window. Based on the description
of standard output data in “4.2.3 Output Process Data” on page 27, enter "2" in the "Modify" field
and press Enter to output to Pin2 of port 0 of the GS20-EIP-8L module, providing UA power supply
for the IO-Link slave. Based on the description of IO-Link output process data in “4.2.3 Output
Process Data” on page 27, enter "255" in "Modify" field of "IOL_Port0_Outputs[0]". Press Enter to
output a valid lower 8-bit data to the slave via IO-Link.
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h. Short-circuit one output pin and one input pin of the IO-Link slave to receive the corresponding
IO-Link input process data. Expand the "Input" data in the "Watch" window and the corresponding
IO-Link input data can be detected in "IOL_Port0_Inputs".

4.4.3 Programming with Rockwell Studio 5000

Prerequisites

● The cables are connected correctly.
● Rockwell Studio V33.00.00 and above is installed.
● The EDS file of the GS20-EIP-8L module is imported into InoProShop. The EDS file can be obtained

under Software and Commissioning Tools on the GS20 series product page at www.inovance.com.
● EIP-Tools is downloaded and installed from ODVA official for IO-Link slave parameter configuration.

www.inovance.com
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Procedure

1. Create a project.

a. Open the Studio 5000 software, click "New Project", and select "1756-L71 ControlLogix5570
Controller" for the controller model.

b. Select the corresponding software version (①) and the matching PLC module (②) as needed, and
click "Finish" (③).
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c. In the menu bar, select "Communications" > "Who Active" to search for connected devices.

d. Set the local network card to the same network segment as the PLC device.
Select "Control Panel" > "Network and Sharing Center" > "Ethernet". Click "Properties (P)" and
select "Internet Protocol version 4 (TCP/IPv4)" in the "Ethernet Properties" dialog box. In the pop-
up window, select "Use the following IP address (S)", set the "IP address (I)", and click "OK".
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e. Select "AB_ETHIP.1.Ethernet" (①), click the detected PLC model "192.168.1.18, 1756-EN2TR, 1756-
EN2TR/C" (②), and click "Go Online" (③).

f. The background status is shown below.
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2. Import the EDS file

a. Select "Tools" > "EDS Hardware Installation Tool" (①), select "Register an EDS file(s)" (②), and
click "Next (N)" (③).
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b. Click "Register a single file" (①), click "Browse" to select the EDS file for the device (②) and then
click "Next" (③).
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3. Configure the project.

a. Select "I/O Configuration" > "1756 Backplane" on the left of the interface, and click "New Module".

b. In the "Catalog" tab of the "Select Module Type" window, search for "1756-EN2TR" (①), select
"1756-EN2TR" (②), and click "Create" (③).
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This device requires the addition of an Ethernet module for use. Some other devices can directly search for the
GS20-EIP-8L without adding the module.

c. In the "General" tab of the "New Module" window, enter the module "Name" (①) and "IP Address"
(②) with the same IP as the device, and then click "OK".
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d. Select "I/O Configuration" > "1756 Backplane" on the left of the interface, and click "New Module".
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e. In the "Catalog" tab of the "Select Module Type" window, search for "GS20", select "GS20-EIP-8L",
and click "Create".



Program Commissioning

‑69‑

f. In the "General" tab of the "New Module" window, enter the module "Name" (①) and "IP Address"
(②) with the same IP as the device, and then click "OK".

g. To modify the module configuration parameters, double-click the module (①), select "General"
(②), and click "Change".
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1). In the "Module Definition" dialog box, select the connection method, set the default
parameters, and click "OK".

2). To modify the input/output data display length, click the lower triangle to select the data
length, and click "OK".
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h. To modify the device communication RPI cycle, double-click the device and click "Connection"
(①). Set the RPI cycle in the "Requested Packet Interval (ms)" (②) and click "OK" (③).

4. Configure the mapping data.

a. Select "Logic" > "Monitor Tags" from the menu bar.
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b. The configuration interface includes the module configuration data (C), input channel (I), output
channel (O), and the corresponding byte size (Data Type).
All module configuration data in the software is of SINT type. Take module configuration data as
an example.

Parameters C.Data[1] and C.Data[0]correspond to the higher and lower eight bits of an INT type
data respectively. In the configuration data, the first 10 bytes are of INT type, so two parameters
correspond to one set of parameter mapping, while the other SINT types correspond to the
module USINT one-by-one.

The "Port Function" of each port of the module is configured as IO-Link mode (binary:
0101010101010101; decimal: 21845; hexadecimal: 5555). The values of the two channels are both
55 and the "Style" value is set to HEL (hexadecimal). So C.Data[0] and C.Data[1] shall both be filled
with 55.

For input and output process channels, synchronous conversion is required for display.

No. Name
① Port Function

② Pin2 Safe Function
③ Pin4 Safe Function
④ Pin2 Function
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No. Name
⑤ Pin4 Function

⑥ IOL Port 0 Cycle Time

Configure the "Port Function" as IO-Link mode, Pin2/Pin4 output function upon network
disconnection as outputting 0 V, Pin2 function as "output enable", and Pin4 function as "output
mode", as shown below.

"Style" adjusts the display format to facilitate the calculation of channel mapping values.

c. Click "Download" to compile and download the program to the PLC device.
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d. After the completion of download, switch to Run mode, as shown below.

e. The process data output write values for IO-Link port 0 is shown below.
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5 WEB Function
This product supports online viewing of product information, upgrading device firmware, and
modifying the IP address.

The system provides two types of access permissions: normal mode and expert mode. Upgrading
device firmware and modifying the IP address require users to log in with expert mode permissions.

● Normal mode: The login password is "inogsnormal". Users can only view product information, that
is the "Home" and "Product Introduction" tabs on the WEB interface.

● Expert mode: The login password is "inogsexpert". Users can view product information, upgrade
device firmware, and modify the IP address.

Interface Introduction

● On the "Home" tab, users can view product information, including the indicators of the equipment
(①), information about the slaves connected to each port (②), and basic data (③).

● On the "Equipment Maintenance Information" tab (in expert mode), users can view master's device
information (①), upgrade the device firmware (②), and modify the IP address (③).

■ To upgrade device firmware, contact Inovance technical engineers.
■ To modify the IP address, refer to “ IP Address Modification” on page 76.

● On the "Product Introduction" tab, users can view information about the GS20 series of high-
protection IO products.

User Login

Access the WEB interface using the IP address (default IP address is 192.168.1.66). Click "Login" and
enter the password.

● Normal mode: The login password is "inogsnormal".
● Expert mode: The login password is "inogsexpert".

IP Address Modification

In expert mode, click "Device Maintenance Information". In the "IP Modification" window, users can
change the IP address, subnet mask, and gateway address.

● IP address: When the device's DIP switch is not set to 0, only the first three digits of the IP address
can be modified. When the DIP switch is set to 0, the entire IP address can be modified, but the
fourth segment cannot be set to 0 or 255.

● Subnet mask: It must follow the binary format of continuous "1"s in higher bits + continuous "0"s in
lower bits, preventing alternating (e.g. 11100111) or discontinuous (e.g. 11101000) masks.

● Gateway address: It must be in the same subnet as the IP address, meaning it shares the same first
three digits with the IP address.

Note
The modified IP address will take effect the next time the module is powered on. The new IP address is required to
access the WEB interface.
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6 Troubleshooting
There is a set of diagnostic messages for each IO-Link port, which is reported through input process
data. Each port can store up to three diagnostic messages. The specific fault codes are shown in the
table below.
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Source Fault Code Description Solution

IO-Link master 0x1800 Device not detected by the
port

Check whether the port device
configured as IO-Link is connected.

0x1802 Invalid vendor ID Check whether the configured
Vendor ID is consistent with the
connected port device when I/O-
Link validation mode is enabled.

0x1803 Invalid Device ID Check whether the configured
device ID is consistent with the
connected port device when I/O-
Link validation mode is enabled.

0x6000 Invalid cycle time Check whether the configured cycle
time meets the communication
requirements of the connected port
when I/O-Link validation mode is
enabled.

0x6001 Incorrect slave version Check whether the version of the IO-
Link slave device connected to the
port meets the requirements when
I/O-Link validation mode is enabled.

0x1806 Pin1 short-circuited Check whether Pin1 encounters a
short circuit.

0x1807 Pin1 overcurrent Check whether Pin1 encounters an
overcurrent.
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Source Fault Code Description Solution

IO-Link slave 0x4210 Overtemperature The ambient temperature is too
high. Decrease the temperature
before using the module.

0x4220 Undertemperature The ambient environment is too
low. Increase the temperature
before using the module.

0x5011 Loss of retentive data upon
power failure

Retention of configuration
parameters fails. Re-configure the
parameters.

0x5100 Device power supply fault The UA power supply of the module
fails. Enable the power supply to pin
2 on the master or use the external
UA power supply.

0x5110 System power supply
overvoltage

The US power supply voltage of the
module is higher than the normal
operating voltage. Decrease the US
power supply voltage.

0x5111 System power supply
undervoltage

The US power supply voltage of the
module is lower than the normal
operating voltage. Increase the US
power supply voltage.

0x7710 Short circuit The module encounters a short
circuit. Check the external wiring.

0x6320 Parameter fault The module parameters are
configured incorrectly. Configure the
parameters correctly according to
the product data.

0x6321 Parameter loss In expert mode, an input signal is
detected for a channel configured as
output. Modify the input/output
configuration parameter 0x41
according to actual usage.
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7 Appendix: Version Matching Information
You can get the module firmware from Inovance technical support engineers. The InoProShop
software can be downloaded from the software and commissioning tool interface of any medium-sized
PLC series at https://www.inovance.com. The following table describes the version matching
information.

Module Firmware Version InoProShop version

2.0.0.0 and later V1.7.3 SP2 and later

https://www.inovance.com/portal/product/details?productId=488.


Service and Support
Should you encounter a safety accident during the use or operation of the product, or face challenges
in operating and maintaining the equipment, which remain unresolved after the relevant
documentation is consulted, we provide multiple channels to ensure prompt resolution:

● Channel #1: Contact service@inovance.com.
● Channel #2: Visit https://www.inovance.com/global to access document downloads, after-sales

support, spare parts ordering, repair applications, and authenticity verification services.
● Channel #3: Download My Inovance app (https://zshc-eu.inovance.com/download-pc/) where you

can access products info and documentation, and query product parameters.

We are committed to providing you with quick and professional technical support, and we look
forward to your satisfaction and trust.

Service and Support
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